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1
Configure Active Fabric Manager as a Virtual 
Appliance
Starting with Release 1.5 of Active Fabric Manager (AFM), you can deploy the AFM as virtual appliance on a VMware® 
ESX® virtual machine or Workstation™. In this guide, you learn how to configure the AFM as a virtual appliance. The 
instructions in this document assume you have already installed and configured an ESX host or workstation where you 
plan to run AFM. For additional information about installing and configuring the ESX virtual host machine or Workstation, 
consult the VMware documentation.

To configure AFM as a virtual appliance:

1. Review the Prerequisites 

2. Deploy the OVF Template

3. Start the AFM VM

4. Manage the AFM Virtual Appliance

5. Perform Initial Configuration

Prerequisites
NOTE: If you are using the AFM VM as a syslog and a TFTP or FTP server, you do not need to gather the following 
information.

Before you begin, gather the following information:

• Syslog IP addresses — IP address of remote syslog server.

• TFTP or FTP server address — IP address of TFTP or FTP server for the Dell Networking Operating System 
(FTOS) software images and configuration files during bare metal provisioning (BMP). If you are using an FTP 
server, obtain the user name and password.

Hardware Requirements
Disk Space           1TB 7.2K RPM SATA 3.5 Hot Plug Hard Drive

System Type         64-bit operating system

Processor              Intel® Xeon® E5620 2.4Ghz, 12M Cache,Turbo, HT, 1066MHz Max Memory

Memory                32GB Memory (8x4GB), 1333MHz Dual Ranked LV RDIMMs for 2 Processors, Advanced ECC

Virtual Appliance Requirements
AFM runs as a virtual appliance. It requires the following software to host the solution:

• VMware® Workstation™ version 8.0.5 and higher
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NOTE: VMware® Workstation™ does not support HA and FT.

• VMware® vSphere® Hypervisor (ESXi) 5.0 and higher (must meet virtual appliance, port access, and listening 
port requirements)

NOTE: VMware® vCenter™ is required for HA and FT.

Deploy the OVF with HA and FT 
The following are required to implement High Availability (HA) and Fault Tolerance (FT) using a VMware® ESX® Virtual 
Machine :

• VMware® vCenter™ 5.0 Standard License                                                                                                              

• ESXi® 5.0 Enterprise Plus License                                                                                                   

• Dell M1000e chassis, if you are using MXL Blade switches.                      

• iSCSI or Fiber Channel Central Storage

• Shared storage for the OVF

NOTE: By default, the AFM VM CPU is set to 2. To use the HA feature, change the virtual CPU to 1.

Deploy the OVF without HA and FT 
The following are required to deploy AFM without the HA/FT solution, using a VMware® ESX® Virtual Machine:

• VMware® ESXi® 5.0 Open Source License                                                                                                       

• Servers (rack or blade switch).  If you are using MXL blade switches, requires a M1000e blade chassis) 

• Shared storage for the OVF

NOTE: By default, the AFM VM CPU is set to 2.

Deploy the OVF with HA
When you deploy the AFM with HA only using a VMware® ESX® VM, the requirements are as follows:

• VMware® ESXi® 5.0 Open Source License   

• Shared storage for the OVF

NOTE: By default, the AFM VM CPU is set to 2. To use the HA feature, change the virtual CPU to 1.

AFM Client Browser Requirements
• Internet Explorer® 9

• Firefox® 12 and higher

Port Usage
To troubleshooting connectivity issues with the AFM server, use the following table
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Table 1. Ports

Port   Description

20 & 21   FTP

22       SSH and SCP (communication to switches and CLI access to AFM server)

23    Telnet (communication to switches)              

67 & 68   DHCP

69       TFTP

80 AFM server ports used to take request from client (browser)

123 NTP

161 For the SNMP get and set protocol between AFM server and switch.

162 For the SNMP trap listener between AFM server and switch.

443 For the HTTPS communication protocol where the AFM takes requests from the client browser.

5432 Database server

8080          TCP/UDP

61616 ActiveMQ

Disabling VMotion on an ESX/ESXi Host
For information on how to disable VMotion® on an VMware® ESX/ESXi® host, see the VMware documentation at http://
kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1010376 or perform a 
search in the VMware knowledge using the key words “Disabling VMotion® on an ESX/ESXi host”.
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Step 1: Deploy the OVF Template
You can deploy the Open Virtualization Format (OVF) template with the VMware ESX virtual machine or Workstation 8.0.5 
64-bit.  

This section contains the following topics:

• Deploy the OVF Template using the VMware ESX Virtual Machine

• Deploy the OVF Template Using Workstation 8.0.5

Deploy the OVF Template Using a VMware ESX Virtual Machine 
Before you can configure and use AFM, deploy the provided OVF template on a VM on your ESX/ESXi server.

Important: By default, the AFM VM CPU is set to 2. To use the HA, FT, or both, change the virtual CPU to 1.

To deploy the AFM OVF with the vSphere client:

1. Start the VMware® vSphere 5.1 client on your ESX® server or vCenter™.

2. Copy the AFM OVF template files from the directory where you have stored the AFM package to the location that 
the vSphere client can access it. 

NOTE: If you are using HA or HA with FT, make sure that the OVF uses shared storage. To enable FT, select 
the virtual host and then right click to select the Fault Tolerance > Turn On Fault Tolerance option.

3. In the vSphere client, select File > Deploy OVF Template. 

4. Choose the Deploy from file option and browse to where you copied the AFM OVF file.

5. Select the AFM1.5.ovf file and then click the Next button. 

Important: At the Disk Format screen, make sure you select the Thick Provision Lazy Zero option to ensure 
that the AFM has the required disk space for all storage to be immediately allocated.

6. Start the VM. See Step 2: Start the VM.

Deploy the OVF Template Using Workstation 8.0.5
NOTE: Workstation 8.0.5 is primarily used for pre-sales engagements. It does not support HA or FT.

To deploy the AFM OVF template using workstation:

1. On the VMware Workstation, navigate to the File > Open menu and specify the path of the VM AFM file with 
the .ovf extension.  For example, AFM1.5.ovf. 
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Figure 1. Import VM AFM File

2. Click the Open button. 

The Import Virtual Machine screen displays.

Figure 2. Import Virtual Machine

3. In the Name for the new virtual machine field, enter the name of the new virtual machine (VM). 

4. Click the Import button to import the OVF file.

The License Agreement screen is displayed.
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Figure 3. AFM License Agreement

5. Click the Accept button. 

The Virtual Network Editor screen displays.
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Figure 4. Virtual Network Editor

6. Use the Edit menu for the Virtual Network Editor. 

7. Make sure that the “Vmnet8 adapter” is available and do the following:

– Select the NAT (Share host’s IP address with VMs) radio button.

– Check the Connect a Host virtual adapter to this network option.

– Uncheck (disable) the Use Local DHCP service to distribute IP address to VMs option.

8. On the VM, right click on the Settings option.

9. Remove the current network adapter.

10. Click the Add button to add a new adapter.

The Add Hardware Wizard screen displays.
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Figure 5. Virtual Machine Settings

a. Select the Custom: Specific virtual network option and then select the VmNet8(NAT) from the pull-down 
menu. 

b. Check the Connect at power on option.

c. Click the Finish button. 

The Virtual Machine Settings screen displays.
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Figure 6. Virtual Machine Hardware Settings

11. Click the Advanced ... button. 

The Network Adapter Advanced Settings screen displays.
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Figure 7. Network Adapter Advanced Settings

12. Click the Generate button to ensure that a MAC address is assigned to this interface.

13. Click the OK button. This creates a virtual adapter on the VM to use your laptop as a host machine and its network.

14. Power on the VM. 

15. Go to the VM console. 

The Active Fabric Manager (AFM) Virtual Appliance screen displays.
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Figure 8. Active Fabric Manager (AFM) Virtual Appliance options

16. On the VM console, select the Configure System option.

The Select Action screen displays.
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Figure 9. Select Action

17. Select the Device configuration option. 

Important: The IP to be assigned must be in the range as shown in the vmNet8 on your virtual network editor 
in step 6.

The Network Configuration screen displays.
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Figure 10. Network Configuration

18. Ping the IP address assigned to the AFM to verify connectivity. For information about configuration additional 
network settings, see Active Fabric Manager (AFM) Virtual Appliance.

19. On your browser, enter the IP address of your AFM and login to perform initial configuration using the AFM Setup 
wizard. See Performing Initial Configuration.

20. When you complete the initial configuration, the AFM console displays the Getting Started wizard. 
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Figure 11. Getting Started Wizard
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Step 2: Start the Virtual Machine
After you have completed the OVF wizard and finished deploying the template, you can start the AFM VM console.

NOTE: Before you start the VM console, modify the VM settings as needed using the Edit Settings option.

1. Start the VM by clicking on its name and choosing Power > Power On.
2. Open the VM Console by right clicking on its name and choosing Open Console.
3. Open the Console, and log in with the default credentials.

The AFM user name is “superuser” and password is “Superuser1”.

NOTE: When the software requires an ESXi Shell CLI command, the ESXi Shell CLI user name is “superuser” 
and the password is “Superuser1”.

4. Manage the AFM virtual appliance. See Step 3: Manage the AFM Virtual Appliance
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Step 3: Manage the AFM Virtual Appliance
After you have deployed the AFM OVF and performed the initial configuration, you can use the AFM Virtual Appliance to 
perform the following tasks:

• Configure the System

• Change the AFM superuser password

• Update the AFM Server

• Set AFM Software to the Next Reboot

• Restart AFM Application

• Reboot the AFM Server (VM)

• Transfer Files

• Edit Files

• Upload Switch Software Image

• Restore Database

• Log out

NOTE: To access the AFM virtual appliance, go to the AFM VM, click the Console button and then login as 
superuser. The first time you log in from the console or SSH using "superuser", if there is an IP assigned to the VM, 
the AFM prompt you to change the password for "superuser". This password is used for both the web URL login and 
console login. If no IP is assigned to the VM (which means that the DHCP is not enabled), AFM prompts you to do 
the network configuration. The VM then reboots.

The AFM virtual appliance options are show in the following screen shot.

23



Figure 12. AFM Virtual Appliance Options

Configuring the System
To configure the device settings, use the Configure System option.

• Device configuration (Network Configuration) — Use this option to use a static IP to the AFM Ethernet 
controller, change another device eth0 attribute, or add a new device such as a new interface.

• DNS configuration — Use this option to configure the AFM DNS settings.

To configure device settings:

1. Select the Configure System option and press the Enter button.
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Figure 13. Configure System

The following network configuration warning message displays.
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Figure 14. Network Configuration System Warning Message

2. Enter ‘Y’ to continue.

The Select Action screen displays.

Figure 15. Select Action Screen

3. Select the Device configuration option. To navigate between elements, use the Tab and down arrow keys.

The Network Configuration screen displays.
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Figure 16. Network Configuration Settings

4. Modify the following settings as needed:

– Name — Assign the name of AFM Server

– Device — Assign or select the NIC Card to be used.

– Use DHCP — Select to enable DHCP to assign an IP address to the VM

– Static IP — Specify the static IP Address of the AFM server.

NOTE: To verify connectivity, ping the IP address assigned to the AFM. If the destination host is 
unreachable assign the same IP address.

– Netmask — Specify the subnet mask of the static IP address for the AFM Server.

– Default gateway IP — Specify the gateway IP Address of the AFM server.

– Primary DNS Server — Specify the primary DNS server address. To enable the DNS server on AFM 
Server, use this option.

– Secondary DNS Server — Specify the secondary DNS server address.

5. Select OK to save your changes.

6. Select Quit to exit this screen.

To configure AFM DNS settings:

1. Select the Configure System option.

2. Select the DNS configuration option.

To navigate between elements, use the Tab and down arrow.

3. Modify the following settings as needed:
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Figure 17. DNS Settings

– Hostname — Configure the hostname for the AFM server.

– Primary DNS — Configure the primary DNS.

– Secondary DNS — (Optional) Configure the secondary DNS.

– Tertiary DNS — (Optional) Configure Third DNS.

– DNS search path—Configure the DNS search path.

4. Select the OK option to save your changes.

5. Select Quit to exit this screen.

Changing the AFM Superuser Password
To change the AFM superuser password:

1. Select the Change AFM Superuser Password option.

2. Press the Enter button.
The CHANGE AFM SUPERUSER PASSWORD screen displays.
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3. In the Enter current superuser password field, enter the superuser password. For example, Superuser1.

NOTE: 

The password must have 8 to 32 characters and include at least 3 categories from the following:

a. lowercase alphabetic character

b. uppercase alphabetic character

c. digit number (0-9)

d. special character

4. Press the Enter button.

5. In the Confirm New Superuser Password field, enter the new superuser password one more time to confirm the 
superuser password. 

6. Press the Enter button to return to the main menu. 

Update the AFM Server
To upgrade the AFM server:

1. Update the AFM Server

2. Set AFM Software to Next Reboot

3. Restart AFM Application or 4. Reboot the AFM server. 

To update the AFM server:

1. Select the Update AFM Server option and press the Enter button.

The UPDATE AFM Server screen displays.

2. Enter 'y' to download the latest AFM software package (RPM format) file from remote URL to available partition or 
enter 'n' to download the (AFM software package RPM format) file from the local workstation (where the AFM 
console is launched) to the AFM server.

3. If the location is a remote server, enter the URL location of the RPM file on the remote server and then click the 
Enter button using the following formats:
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– https://ipaddress/path_to_rpm.file

– ftp://ipaddress/path_to_rpm.file

– sftp://ipaddress/path_to_rpm.file

4. If the location is local, enter the absolute path of the RPM file and then click the Enter button. 

5. If required, enter you username and password.

6. Press the Enter button to return to the main menu. 

NOTE: 
To use the new RPM on the active partition, Set the AFM Software to Next Reboot and then Restart the AFM 
Application.

Setting the AFM Software to the Next Reboot
There are two versions of the AFM software package: one in the current partition and the other in the available partition.

To select the AFM software and partition for the next reboot:

1. Select the Set AFM Software to Next Reboot option and press the Enter button.

2. Enter ‘y’ and then the Enter button to apply the available update on the next reboot. 

3. Press the Enter button to return to the main menu. 

Restarting the AFM Application
To restart the AFM application:

1. Select the Restart AFM Application option and press the Enter button.

Figure 18. Restarting the AFM Application

2. Enter y to restart the application. 

3. Press the Enter button to return to the main menu. 
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Rebooting the AFM Server (VM)
To reboot the AFM Server VM:

1. Select the Reboot AFM Server option and press the Enter button. 

2. Enter y to reboot the AFM Server VM.

3. Press the Enter button to return to the main menu. 

Transferring Files
To transfer all files from the AFM server to the remote server using the FTP or TFTP:

NOTE: The FTP or TFTP was performed during the AFM server initial configuration set up.

1. Select the Transfer File option.

Figure 19. Transfer Files

2. Press the Enter button.

3. Enter the file type to transfer:

– 1. Syslog 

– 2. AFM Database Backup

– 3. AFM Performance Database Backup

4. Press the Enter button.

5. Click y to upload all the files to the FTP or TFTP server.

6. Press the Enter button.

7. Press the Enter button to return to the main menu. 

Editing AFM Files
To edit the following AFM system files, use the Edit File option.

31



• 1. logback.xml — Enables or disables debugging.

2. config.properties — Adjust system performance.

To edit an AFM system file:

1. Select the Edit File option.

2. Enter an edit file option (1 or 2):

– 1. logback.xml

– 2. config.properties

Figure 20. Edit AFM File System

3. Press the Enter button.

4. Edit and save the file using the vi editor commands such as :w (save file) and quit :q: (quit editing). 

5. Press the Enter button to return to the main menu. 

Uploading Switch Software Image
To upload a new switch software image (which is not already packaged as part of AFM server) to the AFM local FTP/
TFTP server from a remote URL, use the Upload Switch Software Image option.

To upload switch software from the AFM:

1. Select the Upload Switch Software Image option and press the Enter button.
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Figure 21. Upload Switch Software Image Screen: Choose Switch Model

2. Enter a switch model option: 1, 2, 3, 4, 5, or 6. 

– 1. MXL Blade

– 2. S4810

– 3. S4820–T

– 4. S55

– 5. S60

– 6. Z9000

3. Enter the URL location to upload the switch software image to using the formats listed in the Upload Switch 
Software Image screen.
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Figure 22. Upload Switch Software Image Screen: URL Location

4. For FTP, enter your user name and password. 

Figure 23. Upload Switch Software Image Screen: Successful Upload

5. Press the Enter button to return to the main menu. 
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Restoring Database
To restore the AFM configuration database:

1. Select the Restore Database option.

The RESTORE DATABASE screen displays.

Figure 24. AFM Restore Database Options

2. Enter 1 for the 1. AFM Database option. 

The AFM DATABASE FILES screen displays.

3. Enter an AFM database file option. 

4. Enter “Y” to restore the database process and restart the AFM application. 

To restore the AFM performance database:

1. Select the Restore Database option.

The RESTORE DATABASE screen displays.
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Figure 25. Restore Performance Database Option

2. Enter 2 for 2. AFM Performance Database option. 

The PERFORMANCE DATABASE FILES screen displays.

3. Enter a performance database file option. For example, enter “1”.

4. Enter “Y” to restore the selected performance database and restart the AFM application. 

Logging Out of the AFM Virtual Appliance
To log out from the AFM virtual appliance:

1. Select the Log out option.

2. Press the Enter button. 
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Step 4: Perform Initial Configuration
After you deploy the AFM server as a virtual appliance, the AFM Setup wizard starts when you first system login to the 
AFM. This wizard guides you through the AFM initial configuration.

To perform initial configuration:

1. Start a browser.

2. In the URL field, enter the following information using this format to login to the AFM using one of the following URL 
syntax:

– http://vm_ip_address

– https://vm_ip_address

3. Enter your username and password. The AFM Setup wizard starts and displays the Introduction screen.

Figure 26. AFM Setup Introduction Screen

4. Review the Introduction screen.

5. Click the Next button to go to the License Agreement screen.

37



Figure 27. License Agreement

6. Click the Accept button. 

7. To go to the System screen, click the Next button . 

Figure 28. System and AFM User

8. From the System IP Address, select the IP address to manage the AFM.

NOTE: If there are multiple network interface card (NIC) adapter cards on the AFM, select the IP address to 
manage the AFM.

9. Click the Next button to go to the Service Protocols screen.
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Figure 29. Service Protocols

Figure 30. Service Protocols

10. From the File Transfer Protocol pull-down menu, select one of the following options:

– TFTP

– FTP (default)

11. In the TFTP/FTP Settings area, select one of the following options:

– Local — AFM provisioned as a TFTP/FTP server 

Important: When you use the Local option, the TFTP or FTP server must be in the same subnet.

* If you select the local TFTP server option, the TFTP server uses the AFM management IP address.
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* If you select the local FTP server option, the FTP server uses the AFM management IP address. 
Enter the AFM user name and password.

– Remote — External TFTP/FTP server 

* If you select the FTP protocol and remote options, enter the FTP server IPv4 address, user name 
and password.

* If you select the TFTP protocol and remote options, enter the TFTP IPv4 address.

12. Navigate to the NTP Server Settings area.

To synchronize the system clock of the AFM Server to remote the NTP time servers:

– In the Primary IP Address area, enter the primary NTP IPv4 address.

– In the Secondary IP Address area, enter the secondary NTP IPv4 address.

13. Navigate to the DHCP Server Settings area and select one of the following settings:

– Local — AFM provisioned as a DHCP server. When you select this option, the AFM automatically 
integrates the generated dhcpd.config file into the DHCP server on the AFM during pre-deployment.

Important: AFM can be provisioned as a local DHCP server only when the AFM server belongs to the 
same subnet as the network switches management interface subnet.

– Remote — Use External DHCP server. When you select this option, you must manually install the 
dhcpd.conf file that is generated during pre-deployment into the DHCP server before you deploy the fabric.

14. Click the Next button to go to the Syslog IP Addresses screen. 

Figure 31. Syslog IP Addresses

15. In the Syslog IP Addresses area, you can configure up to 8 syslog IP addresses to log events on the switches in the 
fabric. By default, the first syslog IP address entry is the AFM system IP address. The AFM server logs all the 
system and switch events to the syslog server. The log file is located in the following directory: /var/log/afm/
afm.log.

16. Click the Next button to go to the Summary screen. 
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Figure 32. Summary of AFM Setup Settings

17. Carefully review your AFM setup settings and then click the Finish button. After you click the Finish button the AFM 
UI displays the Getting Started screen.

NOTE: You can edit these settings later at the Administration > Settings screen.
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Technical Support
iSupport provides a range of documents and tools to assist you with effectively using Dell Networking equipment and 
mitigating the impact of network outages. Through iSupport you can obtain technical information regarding Dell 
Networking products, access to software upgrades and patches, and open and manage your technical assistance 
center (TAC) cases. Dell Networking iSupport provides integrated, secure access to these services.

Accessing iSupport Services
The URL for iSupport is www.force10networks.com/support/. To access iSupport services you must have a user 
identification (userid) and password. If you do not have one, you can request one at the website:

1. On the Dell Networking iSupport page, click the Account Request link.

2. Fill out the User Account Request form, and then click Send. You will receive your user identification and password 
by E-Mail.

3. To access iSupport services, click the Log in link, and enter your user identification and password.

Contacting the Technical Assistance Center

How to Contact Dell Networking 
TAC

Log in to iSupport at http://www.force10networks.com/CSPortal20/Main/Login.aspx 
and select the Service Request.

Your name, company name, phone number, and E-mail address

• Preferred method of contact

• Model number

• Serial Number

• Software version number

• Symptom description

• Screen shots illustrating the symptom, including any error messages. 
These can include:

– Output from the show tech command or the show tech linecard 
command.

– Output from the show trace command or the show trace linecard 
command.

– Console captures showing the error messages.

– Console captures showing the troubleshooting steps taken.

– Saved messages to a syslog server, if one is used.

Managing Your Case Log in to iSupport and select the Service Request tab to view all open cases and 
RMAs.

Downloading Software Log in to iSupport and select the Software Center tab.
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Technical Documentation Log in to iSupport, and select the Documents tab. This page can be accessed 
without logging in via the Documentation link on the iSupport page.

Contact Information E-mail: Dell-Force10_Technical_Support@Dell.com
Web: www.force10networks.com/support/
Telephone: US and Canada: 1.866.965.5800 /International: 1.408.965.5800
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